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Notes, Cautions, etc.

Illustrations and components are representative only. Your 
unit may differ slightly from those pictured in this document.

        

      

           

NOTE
A note appears like this. A note provides 
additional information to supplement the 
main text which helps you to use and 
understand the product.

Important!
An important message appears like this. An important 
message provides supplemental information which can 
prevent potential problems.

CAUTION!
A caution appears like this. A caution provides 
additional information which, if ignored, may result in 
equipment malfunction or damage.
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Network Configuration Overview

Introduction

Your unit incorporates a fast 100BASE-TX/10BASE-T network 
interface. This User�s Guide explains the functionality of the 
built in network interface and details the network interface 
specifications and several software utilities.*

NOTE
Not all utilities, features or protocols are 
supported by every product. See the front cover 
of this manual for a listing of the items 
supported by your product.
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Specifications 

NOTE
Not all utilities, features or protocols are 
supported by every product. See the front cover 
of this manual for a listing of the items 
supported by your product.

Frame Types � IEEE 802.2

� IEEE 802.3

� Ethernet-II, SNAP, AUTO

Network Interface � 100BASE-TX

� 10BASE-T

Network Protocols � TCP/IP V4, V6

� IEEE 802.1x

� Network layer: ARP, RARP, IP, ICMP

� Session layer: TCP, UDP

� Application layer:LPR, FTP, TELNET, HTTP, 
IPP, BOOTP, DHCP, SNMP, DNS, SMTP, 
POP3, SLP, Bonjour

� IPX/SPX (NetWare)

� Remote printer mode (up to eight file 
servers and 32 queues)

� Print server mode over IPX/SPX (up to 
eight print servers)

� Encrypted password supported in print 
server mode

� EtherTalk

� NetBEUI

� NetBIOS, WINS

Functions � Banner supported

� Monitoring and configuration by Web 
browser

� Printer status notification by E-Mail
Network User�s Guide
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Printing the Network Configuration 
Report __________________________
To print the Network Configuration report from most units:

1. Press the ENTER button on your printer to display 
INFORMATION MENU on the LCD.

2. Press ENTER to select the menu.
3. Press the DOWN ARROW until NETWORK MENU is 

displayed on the LCD.
4. Press ENTER to print.

Keep these sheets handy: they contain information you need 
to set up the printer on your network.

NOTE
If these steps do not work with your unit, check 
your Setup Guide or the On-line User�s Guide 
(on the CD supplied with the unit) for 
instructions.
Network User�s Guide
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Configuration utilities

You can configure the network interface (NIC) by using one of 
the following methods:

NOTE
Not all utilities, features or protocols are 
supported by every product. See the front cover 
of this manual for a listing of the items 
supported by your product.

Configuration Utilities 

Utility Features
System 
Requirements

Admin 
Manager 
Quick Setup 
(see 
page 12)

Configure the NIC easily and 
simply without installing any 
software packages into your 
system. You can set the 
following:

� Enable/disable TCP/IP, 
NetWare, EtherTalk, 
NetBEUI protocols.

� Set IP address, Subnet 
Mask and Gateway for 
TCP/IP manually or by 
using DHCP.

� Set NetWare Mode and 
create Queue/Print 
Server/Printer objects.

� Zone name and Port 
name for EtherTalk.

Windows XP/Vista 
(TCP/IP protocol or 
IPX/SPX protocol 
should be installed).

Admin 
Manager 
Standard 
Setup
(see 
page 14)

Configure the NIC in detail.
Network User�s Guide
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Web Browser 
(see 
page 43)

Configure the NIC and 
printer by using a Web 
browser such as Microsoft 
Internet browser or 
Netscape Navigator.

Microsoft Internet 
Explorer or similar.
Operating system 
that supports Web 
browser.

TELNET (see 
page 44)

Configure the NIC using 
TELNET.

Third-party vendor 
developed TELNET 
client package.
A TELNET Application 
is standard in 
Windows/UNIX/
Linux.

SNMP (see 
page 47)

The printer and network 
interface can be controlled 
using third-party vendor 
developed SNMP application.

Third-party vendor 
developed SNMP 
application.

Configuration Utilities  (cont.)

Utility Features
System 
Requirements
Network User�s Guide
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Network Configuration using 
AdminManager 

AdminManager Quick Setup

The AdminManager Quick Setup utility allows you to configure 
the network interface easily and simply without installing any 
software packages.

 You can configure the following:

� Enable/disable TCP/IP, NetWare, EtherTalk, and NetBEUI 
protocols.

� Set IP address, Subnet Mask and Gateway for TCP/IP 
manually or by using DHCP.

� Set NetWare mode and create Queue/Print Server/Printer 
objects.

� Set the Zone name and Port name for EtherTalk.

Configuration requires a PC with Windows XP or Vista 
operating system, running TCP/IP or IPX/SPX (NetWare).

This utility can only be used on a PC that can be connected to 
the network with TCP/IP or IPX/SPX.

This utility must be used on a PC that is located on the same 
segment as the printer.

NOTE
Not all utilities, features or protocols are 
supported by every product. See the front cover 
of this manual for a listing of the items 
supported by your product.
Network User�s Guide
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1. Insert the CD into the CD-ROM drive. The Setup Utility 
starts automatically. If it does not start, double-click 
\setup.exe (in the root directory) on the CD.

2. Select the appropriate language and follow the on-screen 
instructions.

3. Accept the Software License Agreement.
4. Select the Optional Utilities tab.
5. Then select Install Admin Manager.
6. Select Oki Device Quick Setup and follow the 

on-screen instructions.

7. When the settings are correct, click Execute. The new 
settings are transmitted to the network interface but it 
still operates with pre-transmission settings.

8. Click Finish to validate the new settings. 
9. Switch the printer off for 15 seconds and on again.

6
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AdminManager Standard Setup

AdminManager is a powerful Microsoft Windows-based utility 
to configure all network interface functions easily and 
intuitively via a graphical user interface. 

Configuration requires a PC with Windows XP /2000 Advanced 
Server or Vista, running TCP/IP or IPX/SPX (NetWare).

This utility can only be used on a PC that can be connected to 
the network with TCP/IP or IPX/SPX and must be used on a PC 
that is located on the same segment as the printer.

Installation

1. Insert the Network Software CD into the CD-ROM drive. 
The Setup Utility starts automatically. If it does not start, 
double-click \setup.exe (in the root directory) on the 
CD.

2. Select the appropriate language and follow the on-screen 
instructions.

3. Accept the Software License Agreement.

NOTE
Not all utilities, features or protocols are 
supported by every product. See the front cover 
of this manual for a listing of the items 
supported by your product.
Network User�s Guide
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4. Select the Optional Utilities tab.
5. Then select Install Admin Manager.
6. Select Oki Device Standard Setup and follow the 

on-screen instructions.

7. If you want to install AdminManager on to your local 
drive, select Install and Execute. Otherwise, select 
Execute from CD-ROM. Follow the on-screen 
instructions. 

8. To run AdminManager, check Yes for Do you wish to 
execute AdminManager?, otherwise check No. 

9. Click Finish.

6
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Interface
Select Start > Programs > Oki Setup Utility > Admin 
Manager. 

Explanation of Menu Items 

Menu Item Function

File Search Search printers in your network and list all 
printers.

Status Printer 
Status

Current printer status is 
displayed:

System 
Status

Displays current NIC 
configuration. 
Configuration data can 
be saved as log file.

List of 
Configurat
ion Items

Displays current NIC 
configuration. 
Configuration data can 
be saved as log file.
Network User�s Guide
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Setup Oki 
Device 
Setup

Configure the network interface (NIC).

Setup by 
HTTP

Launch the default browser in your 
environment to access the selected printer�s 
web page.

Setup by 
TELNET

Launch TELNET application in your 
environment to access the selected printer�s 
TELNET port.

Setup Create 
NetWare 
Queue

Create a NetWare queue.
Note: Only visible when using Netware

Delete 
NetWare 
Object

Delete NetWare object.
Note: Only visible when using Netware

Reset Reset the selected network interface.

Test Print Print self-diagnostic test pages.

IP 
Address 
Setup

Set static IP address of network interface 
manually.

Explanation of Menu Items  (cont.)

Menu Item Function
Network User�s Guide
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Device setup

Device Setup allows you to configure the network interface. 
Type the root password (default value is the last 6 characters 
of the MAC address) to configure. Remember that the root 
password is case sensitive. If the MAC address contains any 
alpha characters, type them as upper case. Device Setup 
contains details for the following selectable tabs:

� General (see page 19)

� TCP/IP (see page 20)

� NetWare (see page 22)

� Ethertalk (see page 25)

� NetBEUI (see page 26)

� SNMP (see page 27)

� Email ([Send] (see page 29)

� Email [Receive (SMTP POP3)] (see page 31)

� SNTP (see page 33)

� Maintenance (see page 34)

� SSL/TLS (see page 36)

� IEEE 802.1x (see page 39)

The following section explains each tab�s functionality. 
Depending on your printer, some items in the following 
explanation may not be displayed.y

NOTE
Not all utilities, features or protocols are 
supported by every product. See the front cover 
of this manual for a listing of the items 
supported by your product.
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General Tab

This allows you to set or change the root password used for 
Admin Manager, TELNET and FTP.

Explanation of General Tab Items

Item Explanation

Change root 
password

You can set/change the root password for 
AdminManager, TELNET and FTP.
Network User�s Guide
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TCP/IP Tab 

This allows you to configure TCP/IP related items 

Explanation of TCP/IP Tab Items 

Item Explanation

Use 
TCP/IP 
Protocol

Set TCP/IP protocol as enabled/disabled.

Use DHCP/BOOTP Check this item if IP address, 
subnet mask, default gateway 
and IP addresses for DNS 
primary server and secondary 
servers are retrieved from the 
DHCP or BOOTP server. 
Otherwise, uncheck.

Use IPv6 Enables IPv6.

IP Address Set the IP address of the 
selected network interface.

Subnet Mask Set the subnet mask of the 
selected network interface.

Default Gateway Set the default gateway of the 
selected network interface.

Auto 
Discovery 

Configure items related to Network 
PnP
Use to select Network PnP and 
Bonjour, and to set device name.

DNS 
Server�

Set IP addresses for DNS 
primary and secondary 
servers.
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WINS 
Server

Set IP addresses for WINS 
primary and secondary 
servers and to enter scope 
ID.

WINS 
Server�

Configure items related to the WINS Server.
In this dialogue box, the following items can be 
configured:

Primary Server Set WINS Primary server.

Secondary Server Set WINS Secondary server.

Scope ID Set a Scope ID.

Explanation of TCP/IP Tab Items  (cont.)

Item Explanation
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NetWare Tab 

This is where you can configure NetWare related items.

NOTE
Not all utilities, features or protocols are 
supported by every product. See the front cover 
of this manual for a listing of the items 
supported by your product.

Explanation of Netware Tab Items 

Item Explanation

Use 
NetWare 
Protocol

Set NetWare protocol as enabled/disabled.

Use IPX 
Protocol / 
Use TCP/IP 
Protocol

Set protocol to use.

Print 
Server 
Name

Set Print Server name.

Frame Type Set primary NetWare frame type.

Operation 
Mode

Set NetWare mode.

Check box 
beside 
Bindery 
Setup

Check if you want to use the Bindery mode and 
Bindery Setup button becomes available. If it is 
unchecked, the button is greyed out.
Network User�s Guide
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Bindery 
Setup

Configure items 
related to Bindery 
mode.
In this dialogue box, 
the following items 
can be configured:

Password. Set password for Print 
Server.

Job Polling Time. Set print job polling 
interval in seconds.

NDS Setup Set NDS tree and 
context where Print 
Server was created.

Explanation of Netware Tab Items  (cont.)

Item Explanation
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RPRINTER 
Setup

Available if you 
select RPRINTER 
mode in 
Operation Mode.

By selecting the 
RPRINTER button, 
this is displayed:
Here you can specify 
print servers to which 
the printer can be 
connected.

Time Out Set duration from the 
last data�s arrival to 
freeing of the port in 
seconds.

Printer 
Name

Set the NetWare printer object name.

Explanation of Netware Tab Items  (cont.)

Item Explanation
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EtherTalk Tab 

This allows you to configure EtherTalk related items 

NOTE
Not all utilities, features or protocols are 
supported by every product. See the front cover 
of this manual for a listing of the items 
supported by your product.

Explanation of EtherTalk Tab Items

Item Explanation

Use EtherTalk 
Protocol

Set EtherTalk protocol to enabled/disabled.

Printer Name Set EtherTalk Printer object name.

Zone Name Set the zone name to which the printer belongs.
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NetBEUI Tab  

This allows you to configure NetBEUI related items 

NOTE
Not all utilities, features or protocols are 
supported by every product. See the front cover 
of this manual for a listing of the items 
supported by your product.

Explanation of NetBEUI Tab Items

Item Explanation

Use NetBEUI 
Protocol

Set NetBEUI protocol to enabled/disabled.

Short Printer 
Name

Set a name for the printer. 

Workgroup Set a work group name to which the printer 
belongs.

Comment Set the comments for the printer (optional).
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SNMP Tab 

This allows you to configure SNMP related items.  

NOTE
Not all utilities, features or protocols are 
supported by every product. See the front cover 
of this manual for a listing of the items 
supported by your product.

Explanation of SNMP Tab Items 

Item Explanation

Use SNMP 
Service

ENABLE or DISABLE the SNMP protocol. 

SNMPV1+V3 Select from the drop-down box which (or both) of 
these to use.

SNMPV1 
Settings

SNMP Read & 
Write Community.

Enables these passwords to be 
changed.

SNMPV3 
Settings

Enables Authorization and Privacy (Encryption) 
setup to be done.

SysContact Set SysContact (printer manager) name.

SysName Set SysName (printer model name).

SysLocation Set SysLocation (the location where the printer is 
installed).

Default TTL Set TTL (Time To Live) value.
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Printer Trap 
Setup�

By selecting the button, 
the following dialogue 
box is displayed:
In the dialogue box, the 
following items can be 
configured:

Printer Trap 
Community Name

This community name is 
assigned to outgoing printer 
status traps such as off-line, 
paper out, etc.

TCP#1�5 Set the IP addresses to which a 
Trap packet will be sent. You 
can set up to five IP addresses, 
with the following details:
Printer Reboot
Receive Illegal
On-Line
Off-Line
Paper Out
Paper Jam
Cover Open
Printer Error (any error)

IPX Set node address and network 
address to which a Trap packet 
will be sent.
By selecting the button, the 
following dialogue box is 
displayed:
In the dialogue box, the 
following items can be 
configured:
Printer Reboot
Receive Illegal
On-Line
Off-Line
Paper Out
Paper Jam
Cover Open
Printer Error (any error)

Explanation of SNMP Tab Items  (cont.)

Item Explanation
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E-Mail (Send) Tab  

This allows you to configure SMTP related items.  

NOTE
Not all utilities, features or protocols are 
supported by every product. See the front cover 
of this manual for a listing of the items 
supported by your product.

Explanation of E-Mail (Send) Tab Iems 

Item Explanation

Use SMTP 
Transmit 

Check to enable SMTP

SMTP Server 
Name

Enter name of the SMTP server 

Printer E-Mail 
Address

Enter the printers e-mail address

Destination 
Address 1 - 5

Set the following parameters:

Destination 
Address

Set E-Mail address to which 
email should be sent.

Notify Mode Select PERIOD or EVENT

When PERIOD is selected:
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Check time Used to set the interval at 
which the selected events 
are checked. An e-mail will 
be sent at the specified 
interval for each event 
selected.

Period mode Set ON/OFF for the events 
listed.

When EVENT is selected:

Event Mode Select:
ENABLE (ON), DISABLE 
(OFF) or IMMEDIATE 
(NOWAIT) for the listed 
events. If ENABLE (ON) is 
selected, the check interval 
is settable in hours and 
intervals of 15 mins.

Attach Info... Select whichever information is to be included 
in the e-mail.

Comment... Set up to four lines of text to be included with 
the e-mail as comments.

Authentication... Used to set the following security information:

Use SMTP 
Authentication

Check to Enable SMTP 
Authentication.

User ID Set the User ID for 
Authentication

User Password Set the User Password for 
Authentication.

Others... Set the following:

SMTP Port 
Number

Set the SMTP port number 
(default is 25)

Reply to address Set the E-mail address used 
for the [Reply to] field in the 
mail header.

Explanation of E-Mail (Send) Tab Iems  (cont.)

Item Explanation
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E-mail (Receive) Tab  

Some printers support an email reception function (SMTP/
POP3) allowing the printer to print PDF and text files attached 
to emails. If this tab is not displayed, your printer does not 
support the function.

NOTE
Not all utilities, features or protocols are 
supported by every product. See the front cover 
of this manual for a listing of the items 
supported by your product.

Explanation of E-Mail (Receive) Tab Items 

Item Comments

Use POP Receive Enable/disable receiving E-Mail via POP3. 

POP3 Server Set the IP address or host name of the POP3 
server. 

POP3 Server UserID Set User ID for POP3 server. 

POP3 Server 
Password

Set a password for the POP3 server.
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POP Detail� Set the following:

Use APOP Select if you want to use APOP.

POP3 Port 
Number

Set the port number for APOP  
(default is 110).

Mail Polling 
Time

Set interval to retrieve E-
Mail(s) from the POP3 server. 
Selectable values, OFF, 1min, 
5min (default), 10min, 30 min, 
60 min.

Use SMTP Receive  Enable/disable SMTP receive.

Domain Filter� Set the following:

Use 
Domain 
Filter

Enable/disable domain filtering.

Filter Policy Select ACCEPT (the default) or 
DENY.

Domain 
Filter

Define up to five domain filters.

Explanation of E-Mail (Receive) Tab Items  (cont.)

Item Comments
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SNTP Tab  

In this Tab, you can configure SNTP related items 

NOTE
Not all utilities, features or protocols are 
supported by every product. See the front cover 
of this manual for a listing of the items 
supported by your product.

Explanation of SNTP Tab Items 

Item Comments

Use SNTP Enable/disable SNTP (Simple Network Time Protocol).

NTP 
Server 1 
Address

Set the IP address or host name for NTP Server 1.

NTP 
Server 2 
Address

Set the IP address or host name for NTP Server 2.

Adjust 
Interval

 Set the interval for sending time update requests to the 
server. Select 1 hour (the default), 12 hours or 24 hours.

Local Time 
Zone

Set the local time zone from -12:00 to +13:00. Minute 
interval is selectable from 00 (the default), 15, 30 or 45.

Daylight 
Saving

When this is selected, one hour is added to the local time.
Network User�s Guide
33



Maintenance Tab   

Explanation of Maintenance Tab Items 

Item Comments

LAN Scale Select NORMAL (the default) or SMALL.
Note: For small scale networks (with no 
routing), choose the SMALL setting. For 
more complex networks choose NORMAL.

IP Filter Setup� The following items can be configured:

Use IP FIlter Enable/disable IP Filtering. 
Default is disabled.

Admin IP 
Address

Enter the printer�s IP Address.

IP Address 
Range

Set up to 10 IP Filter address 
ranges: [IP FIlter Range 1] 
through [IIP Filter Range 10].

Printing Enable/disable printing of the 
specified IP address range. 
Default is disabled.

Configuration Enable/disable changing IP 
address ranges. Default is 
disabled.
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Service� The following features can be selected by 
clicking their check box.
TCP/IP Protocol
NetBEUI Protocol 
NetWare Protocol
EtherTalk Protocol
FTP Service
Use Telnet Service
Use Web Service
Use SNMP Service
Use POP3 Protocol
Use SNTP
Use IPP
Use SNMTP
Use encrypted communication for 
configuration data

Explanation of Maintenance Tab Items  (cont.)

Item Comments
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SSL/TLS Tab    

NOTE
Not all utilities, features or protocols are 
supported by every product. See the front cover 
of this manual for a listing of the items 
supported by your product.

Explanation of SSL/TLS Tab Items 

Item Comments

Encryption Strength Set the strength of encryption:
Strong = highest security, slowest speed
Standard = medium security, medium speed
Weak = least security, fastest speed
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Self-signed 
Certificate

For IPP encryption within an organization�s 
internal network (intranet).

Create Certificate� When Self-signed Certificate is selected, the 
following items are configured: 

Common 
Name

The printer�s IP Address 
appears here.

Organization Enter the name of your 
organization.

Organization 
Unit

Optional. Allows you to enter a 
subdivision or department 
name.

Locality Enter the name of the city 
where the organization is 
located.

State/
Province

Enter the state or province 
where the organization is 
located.

Country/
Region

Enter the country or region 
where the organization is 
located.

Key 
Exchange 
Method

Select RSA (the default) or 
Diffie-Hellman(DSS).

Key size Select 512, 1024 (the default), 
or 2048 bits.

Term of 
Validity

Enter a starting and ending 
date (month/date/year) for 
which the certificate is valid.

Explanation of SSL/TLS Tab Items  (cont.)

Item Comments
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CA-signed 
Certificate�

Used for web encryption to provide security 
when printing over the internet. Requires an 
outside certification service which must be 
purchased separately.

Create Certificate� When CA-signed Certificate is selected, the 
following items are configured:

Common 
Name

The printer�s IP Address 
appears here.

Organization Enter the name of your 
organization.

Organization 
Unit

Optional. Allows you to enter a 
subdivision or department 
name.

Locality Enter the name of the city 
where the organization is 
located.

State/
Province

Enter the state or province 
where the organization is 
located.

Country/
Region

Enter the country or region 
where the organization is 
located.

Key 
Exchange 
Method

Select RSA (the default) or 
Diffie-Hellman(DSS).

Key size Select 1024 (the default) or 
2048 bits.

Explanation of SSL/TLS Tab Items  (cont.)

Item Comments
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IEEE802.1X Tab   

NOTE
Not all utilities, features or protocols are 
supported by every product. See the front cover 
of this manual for a listing of the items 
supported by your product.

Explanation of IEEE802.1X Tab Items 

Item Comments

Use IEEE802.1X Enable/disable.

EAP Type The following Extensible Authentication 
Protocols can be configured:

EAP-TLS Selects Extensible 
Authentication Protocol - TLS.

PEAP Selects Protected Extensible 
Authentication Protocol - 
(includes Password).

EAP User Enter EAP User name.

Use SSL/TLS 
Certificate

Enable SSL/TLS certification.

Authenticate 
server

Enable Server Authentication.
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IP Address Setup
If you only use TCP/IP and the printer has not yet been 
configured, occasionally it may not be displayed on 
AdminManager. You can configure the IP address of the printer 
by this function.

1. Select IP Address Setup from the Setup menu.
2. Set Ethernet Address and IP Address then select OK.

3. The Ethernet Address (MAC address) appears in the 
Network Configuration report (see page 9).

Certificate Client 
certificate

File: (User can specify).
Password: (User can specify).
Options to Import, Delete, 
View.

CA certificate File: (User can specify).
Password: (User can specify).
Options to Import, Delete, 
View.

Explanation of IEEE802.1X Tab Items  (cont.)

Item Comments
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Option Menu 

Explanation of Option Menu Items 

Item Explanation

Use TCP/IP 
Protocol

If this item is selected, AdminManager uses TCP/IP 
protocol to search/configure network interfaces.

Use IPX/SPX 
Protocol

If this item is selected, AdminManager uses IPX/
SPX protocol to search/configure network 
interfaces.

Environment 
Setup

TCP/IP Tab
Set broadcast addresses that 
are used to search printers 
using the TCP/IP protocol. If 
Use TCP/IP protocol is 
unchecked, the search will not 
be carried out using TCP/IP.

NetWare Tab
Set network addresses that are 
used to search printers via 
NetWare protocol. If there any 
many NetWare file servers on 
your network, specify the 
network address to which the 
network interface belongs. If 
Use NetWare protocol is unchecked, the search 
will not be carried out using NetWare, but if Auto 
Search is selected, AdminManager will search all 
networks that AdminManager can detect.

SNMP Tab
Obtain the printer name via 
SNMP - Select
Enter Community name. 
Add and Delete
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Help menu
In the Help menu, About is available as well as revision 
information for AdminManager.

Environment 
Setup (cont.)

TimeOut Tab
Search Every: Set response 
waiting time from a network 
interface in seconds.
Time Out: Set time out 
between AdminManager and 
the network interface in 
seconds.
Retry: Set how many times the retry will be carried 
out between AdminManager and the network 
interface.

Explanation of Option Menu Items  (cont.)

Item Explanation
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Network Configuration using a Web 
Browser 

If the printer is connected to the network using TCP/IP, its 
settings and the printer menu settings can be configured using 
a Web browser. Refer to the relevant manuals for details of 
how to launch and use the browser.

Using Microsoft Internet Explorer _____

1. Select Internet Options in the Tools menu.
2. Click on the General tab and click Settings in 

Temporary Internet files.
3. Select Every visit to the page in Check for newer 

versions of stored pages.

Default user name and password
To apply configuration changes using Microsoft Internet 
Explorer (or another Web browser), you will be prompted for a 
username and password. The username is root and the default 
password is the last six characters of the Ethernet (MAC) 
address (any alpha characters must be in upper case).

The root password can be changed to allow you to configure 
the printer by using a Web browser/TELNET/AdminManager. 
To change the root password, select �Password Configuration� 
in the Maintenance tab and follow the on-screen instructions.

Adjusting printer settings
The network addresses used in this manual are shown as 
examples only. Network addresses used in your installation 
must be generated from your own network.

1. Configure the IP Address, Subnet Mask and Gateway for 
the network interface. Launch the Web browser, enter 
the IP Address of the network interface in Address 
(Location/Position) and press the Enter key. The 
Printer Status screen is displayed.

2. Select a tab and items to be changed in the left frame. 
You need to log in as �root� to be able to configure all 
items. Non-root users cannot configure all items.



Network Configuration using 
TELNET 

Example TELNET configuration________
TELNET requires the print server to have a valid IP address 
configured. If the network interface already has an IP address 
configured, skip steps 1 to 3 below.

1. Use the PING command to confirm the connection with 
the network interface.
Example

For IP address 172.168.20.127:

ping 172.168.20.127

If there is no reply, there is a problem with the configuration 
of the IP address (the IP address has been already set 
manually or by the DHCP/RARP server), or with the network. 
Reset the network interface settings to the default (press the 

NOTE
Not all utilities, features or protocols are 
supported by every product. See the front cover 
of this manual for a listing of the items 
supported by your product.

CAUTION!
Please ensure a valid IP address for your 
network environment is used. Use of an 
incorrect IP address can cause serious problems 
on your network.

NOTE
The method of configuring commands may 
differ between workstations. Refer to the 
workstation�s manual.
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reset button next to the Ethernet port on the unit) and try to 
set a temporary IP address. If you still have the problem after 
resetting the network interface, consult the network manager.

2. Login to the network interface using TELNET.
Example

For IP address 172.168.20.127

TELNET 172.168.20.127

You should see a sequence similar to the following 
example:

Trying 172.168.20.127

Connected to 172.168.20.127

Escape character is ‘^]’.

EthernetBoard OkiLAN PRINTER".

login: root

‘root’ user needs password to login.

password:

User ‘root’ logged in.

No. MENU (level.1)

------------------------------------

 1:Status / Information
 2:Printer Config
 3:Network Config
 4:Security Config
 5:Maintenance
99:Exit setup
Please select (1-99)?

3. Enter the number of the item to be changed.
The details window for that item displays.

4. When the configuration is complete, select Exit Setup to 
save your change. To exit without saving your 
modification, select Quit.
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5. Turn the printer off and on again. 

NOTE
The network interface continues to use 
pre-transmission settings until the printer is 
turned off and back on again.
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Network Configuration using SNMP

The printer and network interface can be managed via a 
standard SNMP management station. The network interface 
supports SNMPv1, MIB-II, Oki Data Private MIB and SNMP V3. 
In order for the printer to be managed correctly from an SNMP 
management station, the Oki Data Private MIB needs to be 
added to that management station. Please refer to the SNMP 
manager documentation for information on how to do this.

The printer�s trap address can be set in five places using TCP/
IP and in one place with IPX.

Printer trap settings can be made with TELNET and a Web 
browser.

NOTE
Not all utilities, features or protocols are 
supported by every product. See the front cover 
of this manual for a listing of the items 
supported by your product.

NOTE
The Oki Data Private MIB file can be found in the 
MIB folder on the Network Software CD-ROM or 
the Oki Printing Solutions Website. Please refer 
to the readme file for further information.



Network Configuration using the 
PrintSuperVision Utility 

PrintSuperVision is a web-based application for managing 
printing devices connected to a network. It consists of two 
parts:

� A web application based on Microsoft web server (Internet 
Information Server, IIS or Personal WEB Server, PWS), that 
provides the user interface.

� A monitoring program (PrintSuperVisor) that runs all the 
time, collecting data and saving it in a database for 
statistical reports and sending E-Mail alerts based on the 
saved configuration.

PrintSuperVision requires the .NET environment to be installed 
on the PC on which it runs. The supplied installer will install this 
if necessary.

PrintSuperVision�s main functions are:

� Maintaining the list of printing devices and organizing them 
in logical groups.

� Initially discovering and configuring printers connected to 
the network.

� Locating printers visually on maps.

� Monitoring devices over time and saving data for statistical 
reports.

� Sending email alerts when events occur that affect the 
functionality of printers.

� Statistical reports about usage of printers.

� Tracking maintenance data related to printers.

NOTE
Not all utilities, features or protocols are 
supported by every product. See the front cover 
of this manual for a listing of the items 
supported by your product.
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� Identifying part numbers of consumable items for use with 
your printer.

� Integrating with Oki Data�s on-line web support (for US and 
Canada).

� PrintSuperVision can even manage printers on another 
network provided a copy of PrintSuperVision is also running 
on that network.

System Requirements_______________
The main PrintSuperVision (PSV) application can be installed in 
any of the following Windows systems.

Windows System Requirements for PSV 

Operating 
System

Service 
Pack

IIS1 MDAC and .Net 
Framework

Windows 2003 
Server 
1. Web Edition
2. Standard 
Edition
3. Enterprise 
Edition
4. Datacenter 
Edition

IIS 6.0 
included in 
the OS.
1. IIS 6.0 
installed by 
default 
2, 3, 4. IIS 
6.0 optionally 
installed (on 
the CD)

.Net Framework 1.1 
installed as part of 
the OS.

Windows XP 
Professional

1.0 IIS installed 
as an option. 
Available in 
the Windows 
XP CD.
Install IIS 
before 
installing .Net 
framework.

MDAC and .Net 
Framework are 
available for 
download from 
Microsoft.
MDAC 2.7 and .Net 
Framework Version 
1.0.3705 are 
included as part of 
PSV install.
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Supported Browsers ________________
The PrintSuperVision application can be accessed from most 
Windows, Macintosh, Unix, and Linux desktops.

PrintSuperVision works best when used with Internet Explorer.

When using the Netscape browser, do not select the option 
Images off as the hyperlinks may not work properly. Some 
versions of Netscape browser do not display the frames 
properly, and the Back button may not work correctly.

Windows 2000 
Professional

2.0 Internet 
Service 
Manager 
included in 
the OS.  
Available in 
the Windows 
2000 CD.
Install IIS 
before 
installing .Net 
framework.

MDAC and .Net 
Framework are 
available for 
download from 
Microsoft.
MDAC 2.7 and .Net 
Framework Version 
1.0.3705 are 
included as part of 
PSV install.

Windows 2000 
Server / 
Advanced Server 
/ Datacenter 
Server

Windows XP 
Home

1.0 Works only 
with PSV 
Embedded 
Web Server, 
available in 
the PSV 
Install 
Package.

Windows Vista Not supported

1. An Embedded Web Server option is provided which does not require IIS.

Windows System Requirements for PSV  (cont.)

Operating 
System

Service 
Pack

IIS1 MDAC and .Net 
Framework
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Supported Printers _________________
PrintSuperVision provides general management information 
for printers connected to the network. For Oki printers, 
additional details, reports and added features are available.

While the printer properties are displayed in PrintSuperVision, 
only a few of the printer settings can be set. For setting any 
other printer settings, a hyperlink to the printer�s web page is 
provided in PrintSuperVision.

Installing Print SuperVision __________
This section describes installing Print SuperVision from the 
supplied CD-ROM.

1. Insert the CD-ROM into the CD-ROM drive. The Setup 
Utility starts automatically. If it does not start, 
double-click \setup.exe on the CD-ROM.

2. Select Internet Downloads.
3. Select PrintSuperVision.
4. When installation ends, the Setup complete screen is 

displayed. Click Finish. 
5. Now you should select: Start > Programs > 

PrintSuperVision > PrintSuperVision or double-click 
the PrintSuperVision icon on the desktop for the 
PrintSuperVision server. 

6. For PrintSuperVision client, access http://server IP 
address or host name/PrintSuperVision from the 
Web browser. If you change the port number you should 
add port number. Example: http://192.168.20.127/
PrintSuperVision:8080.

7. PrintSuperVision has an on-line help facility.

NOTE
Some Operating Systems require administrator 
privileges in order to make changes.
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Uninstalling PrintSuperVision_________
To uninstall PrintSuperVision, either

� select: Start > Programs > PrintSuperVision > 
Uninstall PrintSuperVision,

� or from Control Panel, select Add/Remove Programs, 
select PrintSuperVision from the index window and click 
Add/Remove. When the uninstallation is completed, close 
Add/Remove Programs.

In some cases, an empty Okidata/PrintSuperVision/ 
directory may be left behind. Delete the directory manually.
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Network Configuration using the 
Oki LPR Utility 

The Oki LPR Utility is a utility that allows printing data to 
printers connected to the network via TCP/IP. 

The utility is for those Oki printers which support TCP/IP. It 
redirects printing data to the lpr port of the specified IP 
address.

It is an alternative method of connecting printers instead of 
using the Microsoft TCP/IP port.

System Requirements_______________
Operating Systems with TCP/IP support and Oki printers that 
support TCP/IP.

Installing the Oki LPR utility _________

1. Set up the printer driver by designating the output 
destination to Local Printer (LPT1:). For information on 
setting up your printer driver, see the printer user guide.

2. Insert the CD into the CD-ROM drive. The Setup Utility 
starts automatically. If it does not start, double-click 
setup.exe on the CD.

3. Select Optional Utilities.
4. Select Install Direct Network Printing Utility (LPR).
5. Follow the on-screen instructions.

NOTE
Not all utilities, features or protocols are 
supported by every product. See the front cover 
of this manual for a listing of the items 
supported by your product.

NOTE
Some Operating Systems require administrator 
privileges in order to make changes.
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6. Click Next when the Welcome screen is displayed.
7. Verify Destination Folder and Spool Folder and click 

Next.
8. If you want automatic startup as Windows boots up, 

check Register in Startup. If you want to start up in the 
Icon state, check Launch as minimized. Click Next.

9. Verify the program folder name and click Next. 
The installation starts.

10. When the installation ends, the Setup complete screen 
is displayed. Check Yes, I want to launch Oki LPR 
Utility now and click Finish. Check Yes, I want to 
view the ReadMe File if you want to read Readme. 
The OkiLPR utility will start.

11. You may be asked whether it is okay to change write 
permissions for the spool directory. Click Yes to allow the 
utility to be installed correctly.

12. Select Add Printer on the Remote Print menu.
13. Click Discover� to search for the IP address of a 

suitable printer on your network.
14. Highlight the printer you will use and click OK.
15. If your printer is not discovered, click Cancel.
16. Enter an IP address at IP Address and click OK. A 

printer is added to the main window.
Refer to the On-line Help for information on how to use the 
utility.
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Uninstalling the Oki LPR Utility _______

1. Stop the OkiLPR Utility.
2. Select Start > Programs > Okidata > OkiLPR Utility 

> Uninstall OkiLPR Utility.
3. You may find this under Start > All Programs in 

Windows XP.
4. Click Yes when the Confirm File Deletion dialog is 

displayed. 
Deletion of the OkiLPR utility starts.

5. When the deletion has finished, the Uninstall Complete 
screen is displayed. Click OK.

NOTE
If a file that has been added after installation 
exists in the folder to install the OkiLPR utility or 
the folder to spool, you cannot delete the folder. 
Delete any unwanted files before running 
Uninstall OkiLPR Utility.
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Network Printing using Microsoft 
Windows

Overview ________________________
This chapter provides guidelines on how to print over the 
network from various Microsoft Windows platforms. There are 
numerous ways of printing from Windows and the exact set-up 
will vary depending upon your environment. There are also 
numerous versions of Windows, which can be configured as 
either a client, server or both.

Although there are many variants of Windows, the principles 
of network printing are the same. Microsoft provides on-line 
help with all of their operating systems and this is a good 
reference point for the exact details of each configuration 
option within Windows.

Installing a Network Printer__________
There are two ways to set up a Network Printer in Windows:

� Install automatically, using the Oki Driver Installer

� Install it yourself using the Add Printer Wizard

Using the Oki Driver Installer
The Oki Driver Installer program searches for compatible 
printers on the Network, then installs and configures the 
printer drivers with the correct port settings automatically.

Using the Oki Driver Installer program, you can install to the 
following networked printers:

� Directly connected (peer-to-peer) printers via TCP/IP 

NOTE
Not all utilities, features or protocols are 
supported by every product. See the front cover 
of this manual for a listing of the items 
supported by your product.
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The Microsoft standard TCP/IP is installed and configured 
to use Port 9100 with the printer�s IP address.

� Printers not directly connected, but shared via a PC (Client 
Server)

Why use the Oki Driver Installer?
� Automatically discovers printers on the Network (TCP/IP)

� Installs driver and correctly assigns the appropriate port 
and IP address

� Allows easy configuration and sharing of the printer with 
other Network users

� Automatically configures the printer driver with the 
appropriate hardware device options such as hard disc 
drive, duplex unit, etc. (via the Oki Network Extension 
software)

Using the Add Printer Wizard

Method summary:
The following table shows the different ways to connect to the 
printer (port types).

Windows 
2000

Windows 
XP

Windows 
Vista

Windows Rally NO NO YES

Windows standard TCP/IP YES YES YES

Oki LPR YES YES NO

IPP YES YES YES

NetBEUI YES YES NO
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About the different methods

Windows Rally

Windows Rally is an automated �Plug-n-Play� type utility that 
allows users to discover and configure network devices 
effortlessly.

Windows standard TCP/IP port

The standard TCP/IP port simplifies connecting to remote 
printers using the TCP/IP protocol. A computer that acts as a 
print server must run the TCP/IP protocol in order to print.

Can be configured to use either LPR or RAW (e.g. Port9100).

OkiLPR

Used to connect your printer over TCP/IP using an LPR port.

OkiLPR also includes useful tools enabling you to download PS 
and PRN files directly to your printer and automatically redirect 
jobs to other printers on the network.

IPP

The IPP (Internet Printing Protocol) defines a standard protocol 
for printing as well as managing print jobs, media, resolution 
etc.

NetBEUI

NetBEUI (NetBios Extended User Interface) is a protocol that 
was designed for use in small workgroups or LANs. Within 
Windows NetBEUI is used for file and printer sharing between 
computers. It provides a simple method of printing, but it does 
have limitations, and is not as robust as TCP/IP or IPX. 
Typically it is employed in small business or home networks.
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Network Printer IP Address 
Configuration_____________________
Use the Standard Set-up Utility on the CD supplied with your 
unit to configure the IP Address, Subnet Mask and Gateway.

1. Connect the printer to the network and turn it on. 
2. Insert the CD into the CD-ROM drive. The Setup Utility 

starts automatically. If it does not start, double-click 
\setup.exe (in the root directory) on the CD.

3. Select the appropriate language and follow the on-screen 
instructions.

4. Accept the Software License Agreement.
5. Select the Optional Utilities tab.

6. Then select Install Admin Manager.

NOTES
It will not be necessary for printers connected 
to a network using DCHP to use this setup 
method.
Some steps may not display depending on the 
network protocols installed.
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7. Select Oki Device Quick Setup and follow the 
on-screen instructions.

8. Select the appropriate network interface, using the 
Ethernet address to identify it, and click Next. 

If you are using TCP/IP protocol:

a. When using lpr in UNIX and other TCP/IP environments, 
please select Yes. To use in a TCP/IP environment, an IP 
address should be assigned to the Ethernet interface. 

b. If Yes has been selected and TCP/IP is the only working 
protocol and the IP address has not already been assigned, 
you can either obtain an IP address automatically or assign 
an IP address.

c. When Obtain an IP address automatically is selected, the 
device IP address will be automatically assigned by the 
DHCP server. In an environment without a DHCP server, 
please assign the IP address manually. 

d. If you are manually assigning an IP address, you need to 
enter:

�An IP address

�Subnet mask

�Gateway address. 

e. Click Next.

NOTE
The Ethernet address of the printer can be found 
on the Network Configuration printout (see 
�Printing the Network Configuration Report� on 
page 9).

8
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Using Bonjour protocol 

Bonjour is the preferred protocol for printing data from 
the Macintosh environment.

Using NetBEUI protocol 

Using NetBEUI makes it easy to manage your Oki 
product and print within the network environment of 
Windows.

9. When the settings are correct, click Execute. The new 
settings are transmitted to the network interface but it 
still operates with pre-transmission settings.

10. Click Finish to validate the new settings. 
11. Switch the printer off for 15 seconds and on again.
Now that both Windows and the printer have been configured 
to use TCP/IP, the next step is to configure Windows to print 
to the network printer.

NetBEUI Protocol __________________
Network Printer Settings

There are two configurable items under NetBEUI within the 
printer. These can be configured using the standard set-up 
utility described in �Device setup� on page 18.

Although there are some differences in configuration options 
between the various Windows platforms, the procedure for 
printing using NetBEUI is the same.

Please ensure the NetBEUI protocol has been installed in 
Windows. This can be confirmed by checking the network 
settings. If NetBEUI has not been installed please refer to the 
section below.

The relevant Windows installation CD may be required and you 
should follow the on-screen dialog box prompts.

Computer Name Name assigned to the printer

Workgroup PrintServer1

1. Although the workgroup name can be changed, it is 
recommended that it remains as PrintServer.

Comment User definable description
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Windows XP
Although you can install the NetBEUI protocol into Windows 
XP, it may not be supported. You should be able to use 
NetBEUI on LAN connections although you will not be able to 
use this on a Remote Access Service Connections.

1. In the Start menu, select Settings then Control Panel.
2. Double-click on Network Connections.
3. Right-click the adapter to which you wish to add NetBEUI 

and then click Properties.
4. On the General tab, select Install.
5. Select Protocol and then Add.
6. Select Have Disk and insert your Windows XP CD, open 

the Valueadd\msft\net\netbeui folder, select the 
Netnbf.inf file and then click Open.

Now the printer has been configured and NetBEUI has been 
installed, you can configure Windows to print over the 
network.

Windows Vista
NetBEUI is not supported by Windows Vista.
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Printer driver configuration
In the following example, the printer has been configured as 
follows:

1. Set up the printer driver as the default local printer.
2. In the Start menu, select Settings then Printers.
3. Select the relevant printer driver, then Properties.
4. Click on the Details tab in the printer driver.
5. Select Add Port.
6. Select Network and click Browse.
7. Double-click Entire Network, PrintServer and 

OL07DB85. 
8. Select Prn1 and click OK.
9. Check that Network is selected and click OK. 

10. Select Apply and OK to close Properties.
Printing can be carried out using your application software.

� The Master Browser function manages machine information 
from the same Workgroup, and replies to summary 
requests from other workgroups.

� The Master Browser function operates only if the 
Workgroup name is PrintServer.

� The Master Browser function can only manage this network 
interface. If the PrintServer name is put into another 
Workgroup, the network interface will not be able to find it 
on the network.

� A maximum of eight Networks can be managed by the 
Master Browser function.

� Printing cannot be carried out and an error message 
appears when jobs from other users (including other 
protocols) are being printed.

Computer 
Name:

OL07DB85

Workgroup: PrintServer

Comment: Ethernet Board 8100e
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Network Printing using Apple 
Macintosh

Overview ________________________
This section of the guide is for administrators and it should be 
read in conjunction with the relevant MacOS manual. 

To get the best results from your printer, install the Postscript 
Printer Description (PPD) file supplied with your printer and 
use this to customize the Apple PostScript driver that is built-in 
to the OS X. Features provided by the PPD file include:

� Supported paper types

� Paper trays

� Printer resolution

� Printer color matching

Setting up a Network Printer _________

1. If the printer does not already have an IP address, use 
the Printer Setup Utility to assign an IP address (see 
page 67).
To do this, you will need to know the printer's MAC 
address. This can be found on the Network Configuration 
report (see page 9).

NOTE
Not all utilities, features or protocols are 
supported by every product. See the front cover 
of this manual for a listing of the items 
supported by your product.

NOTE
The PPD file must be installed using the Oki 
Driver Installer to ensure that all essential files 
are copied.
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2. Install the printer driver software. This copies the printer 
driver files to the correct location on your Mac OS X 
system.

3. Make a connection to the printer by USB, TCP/IP, 
Rendezvous or AppleTalk. See �Connecting to Your 
Printer� on page 77.

4. If required, enable hardware device options such as 
duplex unit or printer hard disk. See �Configuring Printer 
Hardware Options� on page 82.

MacOS Printer Setup Utility __________
The Printer Setup Utility is a powerful MacOS-based utility for 
configuring all print server functions using a graphical user 
interface. 

Installing the printer setup utility

1. Insert the CD into the CD-ROM drive.
2. Open the Printer Setup Utility folder and double-click 

Installer.
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3. Select the destination directory, then click Next.

4. Ensure the Yes option is selected to activate the utility, 
then click Finish.
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The Printer Setup Utility Interface
The Printer Setup Utility auto-discovers Oki compatible 
network interfaces.

1. Select the correct printer NIC to configure and choose 
Setup menu > Oki Device Setup.

2. At the prompt, enter the Admin password.

3. Select the TCP/IP tab and assign your printer�s IP 
address.

NOTE
The default admin password is the last six digits 
of the MAC Address, minus any punctuation 
marks. e.g., for a MAC (Ethernet) Address of 
00:80:87:A4:55:79, the password would be 
A45579.
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4. Click Apply.

Menu Options

Discover Printers
Locates and lists all printers in your network which have an Oki 
compatible network interface installed.

Printer status monitor
Displays the current status of the printer.

Printer NIC card summary
Displays the network interface summary details.

Change settings
Use this to configure the network interface settings (requires 
Admin password).
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General Tab 

The General tab allows you to change the admin password.

1. Click Change.
2. Enter the current value, then enter the new value and re-

enter it under Confirm �.

3. Click OK.
4. Click Apply.

NOTE
The default admin password is the last six digits 
of the MAC Address, minus any punctuation 
marks. e.g., for a MAC (Ethernet) Address of 
00:80:87:A4:55:79, the password would be 
A45579.
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TCP/IP Tab 

Item Comments 

Use TCP/IP 
Protocol

Enable/disable TCP/IP protocol. 

Use DHCP/BOOTP Click to select this item if the IP 
address, subnet mask, default gateway 
and IP addresses for DNS primary 
server and secondary servers are 
retrieved from the DHCP or BOOTP 
server. 

IP Address Set the IP address of the selected 
network interface.

Subnet Mask Set the subnet mask of the selected 
network interface. 

Default Gateway Set the default gateway of the selected 
network interface. 

Use IPv6 Function Use to enable/disable IPv6.
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Netware Tab

Item Comments

Use NetWare 
Protocol

Enable/disable NetWare protocol.

Print Server Name Set a Print Server name. 

Frame Type Set the primary NetWare frame type. 

Operation Mode Select the NetWare mode:
PSERVER Mode (the default)
RPRINTER Mode

Bindery Setup Configure Bindery mode items, 
including:

File Server to be 
connected.

Specify up to 8 
file servers to 
connect. 

Password. Set a password 
for the Print 
Server.

Job Polling Time Set the print job 
polling interval in 
seconds.

NDS Setup Set the NDS Tree and Context where 
the Print Server was created.

Printer Name Set the NetWare printer object 
name.
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EtherTalk Tab

Item Comments

Use EtherTalk 
Protocol

Enable/disable EtherTalk protocol.

Printer Name Set the EtherTalk Printer object name.

Zone Name Set the name of the zone to which the print 
server belongs. 
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NetBEUI Tab

Item Comments

Use NetBEUI 
Protocol

Enable/disable NetBEUI protocol.

Short Printer 
Name

Set a name for the print server. 

Workgroup Set a name for the work group to which 
the print server  belongs.

Comment Set the comments for the print server.
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SNMP Tab

Open web browser
Displays the printer web page.

Change utility preferences
Use this to configure the utility preferences for broadcast 
addresses for TCP/IP protocol and Time Out.

Item Comments

SysContact Set the printer manager name.

SysName Set the printer model name. 

SysLocatio
n

Set the location where the printer is installed.
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Utility Preferences TCP/IP Tab

Item Comments

Set Broadcast 
Address

Set broadcast addresses that are used to 
search Oki network interfaces using the 
TCP/IP protocol.

Add Click Add to add the address to the list in 
the box.

Delete Select an address in the box, then click 
Delete to remove it.
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Utility Preferences Timeout Tab

Item Comments

Set Timeout: 
Printer Search

[Search Every (20-180sec)]
Set the response waiting time from the 
network interface in seconds. Default is 
30 seconds.

Set Timeout:
Data Send/
Receive

[Time Outs (1-60sec)]
Set time out between AdminManager and 
the network interface in seconds. Default 
is 5 seconds.
[Retry (1-5)]
Sets how many times AdminManager will 
retry to transmit/receive data to/from the 
network interface. Default is 3 retries.
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Connecting to Your Printer ___________

Tiger (10.4)

Bonjour, AppleTalk or USB

1. Launch Printer Setup Utility
This is located in the Applications > Utilities folder.

2. Click Add�.
3. Select your printer model from the Default Browser.

4. Click Add.
Depending on the connection type, you may be prompted 
to configure any additional printer hardware options. If 
your printer has options such as a hard disk or second 
tray, switch on the relevant options.

5. Quit Printer Setup Utility.
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TCP/IP Connection

1. Launch Printer Setup Utility
This is located in the Applications > Utilities folder.

2. Click Add�.
3. Click the IP Printer button.
4. From the Protocol menu, choose Line Printer Daemon 

� LPD.
5. Enter the printer�s IP address in Address.

6. Check the correct PPD file for your printer is selected in 
the Print Using menu.

7. Click Add....
You will be prompted to configure any additional printer 
hardware options. If your printer has options such as a 
hard disk or second tray, switch on the relevant options.

8. Click Continue.
9. Quit Printer Setup Utility.
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Panther (10.3) and Jaguar (10.2)

Rendezvous

If you have not already done so, run the Oki software installer 
before following the steps below. 

1. Start the Printer Setup Utility.
This is located in the Applications > Utilities folder.

2. Click Add....
3. From the pop-up menu, choose Rendezvous.
4. Select the printer you wish to connect to.
5. Click Add.
6. Click the Printer Setup Utility menu, and choose Quit 

Printer Setup Utility.
After adding the printer, you should configure printer hardware 
options. Refer to �Configuring Printer Hardware Options� on 
page 82.

NOTE
This utility is called Print Center on Mac OS X 
10.2.x.
If your printer is already listed, your Mac may 
already have discovered the printer before you 
installed the Oki software. In this case, the 
printer may be using the incorrect PPD file or 
may not have the correct hardware options 
configured. You should delete the printer, quit 
Printer Setup Utility, and re-launch the utility 
before continuing.
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IP Connection _____________________
If you have not already done so, run the Oki software installer 
before following the steps below.

1. Start the Printer Setup Utility.
This is located in the Applications > Utilities folder.

2. Click Add....
3. Click the pop-up menu and choose IP Printing.
4. Click the Printer Type menu and choose LPD/LPR.
5. Enter the printer's IP address.

To find the printer�s IP address, you can print a 
configuration page from the printer�s operator panel (see 
page 9).

6. Enter the queue name. If you do not know the queue 
name, leave it as Use Default Queue on Server.

7. Click the pop-up menu and choose your printer model.
8. Click Add.
9. Click the Printer Setup Utility menu, and choose Quit 

Printer Setup Utility.
After adding the printer, you should configure printer hardware 
options. Refer to page 82.

AppleTalk connection
If you have not already done so, run the Oki software installer 
before following the steps below.

NOTES
This utility is called Print Center on Mac OS X 
10.2.x.
If your printer is already listed, your Mac may 
already have discovered the printer before you 
installed the Oki software. In this case, the 
printer may be using the incorrect PPD file or 
may not have the correct hardware options 
configured. You should delete the printer, quit 
Printer Setup Utility, and re-launch the utility 
before continuing.
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1. Start the Printer Setup Utility.
This is located in the Applications > Utilities folder.

2. Click Add....
3. From the pop-up menu, choose AppleTalk.
4. Select the printer you wish to connect to.
5. Click Add.
6. Click the Printer Setup Utility menu, and choose Quit 

Printer Setup Utility.

USB connection
If you have not already done so, run the Oki software installer 
before following the steps below.

1. Start the Printer Setup Utility.
This is located in the Applications > Utilities folder.

1. Click Add Printer....
2. From the pop-up menu, choose USB.
3. Choose a printer to connect to.
4. Click Add.

NOTE
This utility is called Print Center on Mac OS X 
10.2.x.

NOTE
This utility is called Print Center on Mac OS X 
10.2.x.
If your printer is already listed, your Mac may 
already have discovered the printer before you 
installed the Oki software. In this case, the 
printer may be using the incorrect PPD file or 
may not have the correct hardware options 
configured. You should delete the printer, quit 
Printer Setup Utility, and re-launch the utility 
before continuing.
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5. Click the Printer Setup Utility menu, and choose Quit 
Printer Setup Utility.

Configuring Printer Hardware Options __

If you have added additional hardware, for example additional 
paper trays, to your printer these must be enabled in the 
printer driver.

1. Start the Printer Setup Utility.
This is located in the Applications > Utilities folder.

2. Ensure that your printer model is selected.
3. Click the Printers menu, and choose Show Info.
4. From the popup menu, select Installable Options.
5. Select any options appropriate to your hardware, and 

click Apply Changes.

NOTE
Applies to IP and Rendezvous network 
connections only.

NOTE
This utility is called Print Center on Mac OS X 
10.2.x.

NOTE
Not all utilities, features or protocols are 
supported by every product. See the front cover 
of this manual for a listing of the items 
supported by your product.
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Network Printing using UNIX

Overview
Printers support many protocols such as LPD, FTP, TELNET, 
SNMP and IPP, and work within the UNIX environment.

To use the printer within the UNIX environment, the following 
steps are required:

Configuration

Network Interface Setting
The first step in installing the printer under UNIX is to set up 
the IP address, Subnet Mask and Gateway. This section 
explains one way to set them up from a UNIX workstation.

� The network addresses used in this manual are shown as 
examples only. Network addresses used in your installation 
must be generated for your own network.

� Log in as root to change the configuration of the printer.

� If an incorrect IP address, Subnet Mask or Gateway is 
entered, the network may go down or other damage may 
occur. Check the address with your network manager.

The following explanation uses Sun Solaris 2.8 (Solaris 8) as 
an example. The actual commands may differ between 

NOTE
This section does not apply to GDI printers.
Not all utilities, features or protocols are 
supported by every product. See the front cover 
of this manual for a listing of the items 
supported by your product.
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versions of UNIX, so refer to the workstation manuals for more 
information.

1. Log in as root to the workstation.
2. If the printer does not have an IP address already 

assigned, use the arp command to set a temporary IP 
address.

Example: for IP address 192.68.20.127 and network 
interface address 00:80:87:01:00:D2

# arp –s 192.168.20.127 00:80:87:01:00:D2 temp

The Ethernet address (MAC address) 
00:80:87:01:00:D2 in the above example can be 
determined from the Network Configuration report (see 
page 9).

3. Use the ping command to confirm the connection with 
the network interface.

Example: for IP address 192.168.20.127

# ping 192.168.20.127

If there is no reply, there is a problem with the 
configuration of the IP address (the IP address has 
already been set manually or dynamically), or with the 
network. Reset the network interface settings to default 
and try to set a temporary IP address.

If you still have the problem after resetting the network 
interface, consult the network manager.

NOTE
If you do not have superuser rights, the network 
manger should conduct the configuration.
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4. Login to the network interface using TELNET.
Example: Logging in to IP address 192.168.20.127

#telnet 192.168.20.127

Trying 192.168.20.127

Connected to 192.168.20.127

Escape character is ‘^’.

EthernetBoard 8100e TELNET server

login: root

‘root’ user needs password to login.

password: <CR>

User ‘root’ logged in.

No. Message Value (level .1)

1 : Setup TCP/ IP

2 : Setup SNMP

3 : Setup NetWare

4 : Setup EtherTalk

5 : Setup NetBEUI

6 : Setup printer trap

7 : Setup SMTP (Email)

9 : Maintenance

10 : Setup printer port

11 : Display status

12 : IP Filtering Setup

97 : Network Reset

98 : Set default (Network)

99 : Exit setup

Please select (1- 99)?
Network User�s Guide
85



5. Type 1 and  press the Enter key. Perform the following 
settings:
Please select (1- 99)? 1

No. Message Value

1 : TCP/ IP protocol : ENABLE

2 : IP address : 192.168.20.127

3 : Subnet Mask : 255.255.255.0

4 : Gateway address : 192.168.20.1

5 : RARP protocol : DISABLE

6 : DHCP/ BOOTP protocol: DISABLE

7 : Auto IP Address : DISABLE

8 : DNS Server (Pri.) : 0.0.0.0

9 : DNS Server (Sec.) : 0.0.0.0

10 : root password : “******“

11 : Auto Discovery Setup

99 : Back to prior menu

Please select (1- 99)?

6. Logout from the network interface. Turn the printer off 
for about 15 seconds and on again to validate the 
settings.

LPD Printing
Line Printer Daemon (LPD) is the most common protocol for 
printing with TCP/IP to a network printer. Refer to the 
workstation�s manual for details of lpr and lp commands. The 
following explanation in this section uses the printing of print 
file test.prn with printer name Myprinter_lp as an example.
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Logical printers
The printer�s network interface includes three logical printers.

� lp must be used for printing a file created using the printer 
driver.

� sjis must be used for printing a text file of Shift JIS Kanji 
code.

� euc must be used for the printing a text file of the EUC 
Kanji code.

7. sjis and euc function only as PostScript printers.

BSD-based UNIX
Print using the lpr command.

# lpr Pmyprn_lp test.prn

If the lprm command is used, the print job is cancelled.

Example: To delete a print job (Job ID 123) on the 
myprn_lp 

# lprm Pmyprn_lp 123

Verify the printer status using the lpq command.

� The result of lpq may not be displayed correctly depending 
on UNIX operating system specification.

� While the short format of lpq is a UNIX compatible format, 
the long format is unique to this network interface.

Example of the short format: # lpq Pmyprn_lp

Example of the long format: # lpq Pmyprn_lp_lp

Logical printer Printer function

lp For direct output

sjis For Shift JIS Kanji converted output

euc For EUC Kanji converted output
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System V-based UNIX

Print using the lp command.

# lp –d myprn_lp_lp test.prn

Delete a print job using cancel command.

Example: To delete a print job (Job ID 456) in the 
myprn_lp

# cancel myprn_lp  -456

Verify the printer status using the lpstat command.

# lpstat myprn_lp

The result of lpstat may not be displayed correctly depending 
on UNIX operating system specification (e.g. Solaris 2.x).

FTP printing
FTP (File Transfer Protocol) is used for transferring a file with 
TCP/IP. If the print data is sent to a logical printer via FTP, it 
is printed.

Refer to the workstation�s manual for details of the ftp 
command. The following explanation uses print file test.prn 
with printer name myprn_lp as an example.
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Logical directories
The printer�s network interface includes three logical 
directories.

� lp must be used for printing a file created using the printer 
driver.

� sjis must be used for printing a text file of Shift JIS Kanji 
code.

� euc must be used for the printing a text file of the EUC 
Kanji code

� jis and euc function only as PostScript printers.

� You can not send data to the root directory.

1. Log in to the network interface.
When printing with ftp, use any values for name and 
password. However, if the user name is root, the 
password set under TELNET or the utility is required. See 
the appropriate section for details.

Example: Logging in with host name myprn (or IP 
address 192.168.20.127).

# ftp myprn (or ftp 192.168.20.127)
Connected to myprn
220 EthernetBoard 8100e Ver 01.50 FTP Server
Name (myprn:<none>) : root
331 Password required.
Password:<CR>
230 User Logged in
ftp>

The network interface logical directory structure is 
hierarchical. Move to the logical directory; it is not 
possible to output print data to the root directory.

Logical directory Printer function

lp For direct output

sjis For Shift JIS Kanji converted output

euc For EUC Kanji converted output
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2. Move to the preferable logical directory using the cd 
command.

Example: moving to the lp directory and confirming the 
current directory.

ftp> cd /lp
250 Command OK.
ftp> pwd
257 ”/lp” is current directory
ftp>

3. Configure the transfer mode.
There are two types of transfer mode: BINARY mode, in 
which the file content is output as it is and ASCII mode, 
which converts the LF code to the CR+LF code. If a binary 
file converted by the printer driver is transferred, the 
transfer mode has to be BINARY mode.

Example: Changing transfer mode to binary mode and 
verifying the current mode:

ftp> type binary
200 Type set to I.
ftp> type
Using binary mode to transfer files.
ftp>

4. Transfer the print data to the network interface using the 
put command. Two methods of file transfer using the put 
command are available.

Example: Transferring print data test.prn

ftp> put test.prn

Example: Transferring print data specified by absolute 
path/users/test/test.prn

ftp> put /users/test/test.prn /lp
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5. Logout from the network interface using the quit 
command.
ftp> quit

Three states can be verified using the quote command 
stat: the IP address, login user name and transfer mode. 
In addition, printer status can be verified by specifying 
the directory after the stat (lp, sjis, euc).

Example: Displaying the network interface status

ftp> quote stat
211-FTP server status:
Connected to: 192.168.20.10.000.00
User logged in: root
Transfer type: BINARY
Data connection: Closed.
211 End of status.
ftp>

Example: Displaying the network interface status 
(directory name: lp)

ftp> quote stat /lp
211-FTP directory status:
Ready
211 End of status
ftp>
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Troubleshooting

The network addresses used in this manual are shown for 
example only. Network addresses used in your installation 
must be generated from your own network.

Self-diagnostic Test ________________

Printer does not print.
Ensure the printer emulation is set to PS or Automatic.

NG is printed in the self-diagnostic test or Flash 
ROM Check Registers NG.
Turn the printer off for 15 seconds and then on again.

Press the reset button on the rear panel, next to the network 
interface port, to re-initialize the printer.

TCP/IP __________________________

Computer cannot find the network interface.
� Turn the printer off for 15 seconds and then on again.

� Confirm the network interface is enabled on the printer.

� Check there is a response to the PING command.

� Check that the network cable is correctly connected and 
that the green LED close to the printer�s network interface 
is lit. If not, change the cable and try again.

� Open Admin Manager (Start > Programs > Oki Setup Utility 
> Admin Manager, or run it from the CD supplied with your 
unit) and run the Self-diagnostic test (Setup > Test Print).

� Check that the IP Address, Subnet Mask and Gateway are 
correct.

� Check that the TCP/IP protocol is set to Enable.

� Reset the network interface to the factory default settings.

� If DHCP, BOOTP and RARP are not used, ensure they have 
been set to Disable.
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Cannot print with lpr and ftp.
� Turn the printer off for 15 seconds and then on again.

� Check there is a response to the ping command.

� Check the network cable is correctly connected.

� Change the cable and try again.

� Check the host name and IP address are configured in the 
workstation.

� Check the printer port name is configured in the 
workstation.

� There are three port names: lp, euc and sjis. Use lp by 
default as euc and sjis are specific to PostScript printers.

Incorrect user name on the banner page.
� If printing with lpr, the user name printed is unknown and 

the filename printed is the Spool file name.

� If printing with FTP, the user name printed is the user name 
entered during FTP login and the file name printed is the 
transmitted file name. If the print directory name is 
indicated in the put command, the file name is not printed. 
The printer name printed is the logical directory name.

NetBEUI _________________________
The network interface is not identified.

� Turn the printer off for 15 seconds and then on again.

� Check the network cable is correctly connected. 

� Change the cable and try again.

� Check that Microsoft Network Client and NetBEUI have 
been added to the network section of the Windows Control 
Panel.

� Check that the NetBEUI protocol is set to Enable.

� Check that the factory setting of the workgroup name is 
PrintServer and the computer name is ML+ the last six 
characters of the MAC address.

� Check if the computer name of the NIC is different from the 
computer name on the network.
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Error writing to Prn1.
� Check if the printer is online.

� If there is an error message indicating the paper has run 
out, add more paper and cancel the error.

� Check whether another user is printing. Print after the 
other user has finished.

Mac _____________________________

Blank pages or garbled text printed.

Symptoms:

When printing via a USB or TCP/IP connection, you receive 
blank pages or pages printed with a line of garbled text.

Cause:

This issue is normally caused by the data being sent to the 
printer in binary format. The printer may not be able to 
understand data in this format, and therefore may print blank 
pages or garbled text.

Solution:

In your application�s print options, there may be an option to 
send data as ASCII. Choose this option, and print your 
document.

For example, in Adobe Photoshop 7 or Adobe Photoshop CS: 

1. Click the File menu and select Print with Preview. 
2. Click the box Show More Options.
3. From the pop-up menu, choose Output.
4. From the pop-up menu Encoding, choose ASCII.
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Banner print is rotated by 90 degrees and is 
printed at the bottom of the paper.

Mac OS X 10.2.3 or greater
Possible causes and solutions:

� Not enough RAM in the printer to process the print job. 

- Try printing at a lower resolution.

� Incorrect custom paper size being specified.

- Ensure that the Custom Paper Size in both the printer 
driver and your application are exactly the same. 

Mac OS 10.2.3 - 10.2.8 only
� The print job may have been rotated by your application.

An anomaly in the core Mac OS X 10.2.x causes custom 
paper sizes to be incorrectly rotated by 90 degrees, the 
Oki PostScript Printer Description (PPD) file implements a 
counter-rotation to solve this problem. However, some 
applications such as Quark Xpress or Macromedia 
Freehand may create their own PostScript code. For these 
applications, the custom paper size rotation issue does 
not apply.

In such cases, if the Oki PPD file is selected in Quark or 
Freehand�s print dialog, the print job will be incorrectly 
rotated by 90 degrees.

The Oki printer driver contains a Page Rotate option � this 
may be used to fix the problem. Alternatively, you may be 
able to rotate the page in your application program.

NOTE
Ensure that the custom paper size is correct in 
the printer driver (e.g. 320 x 900mm). 
If the custom paper size is wrong (e.g. 328 x 
900mm), the OS X PostScript driver will replace 
this with the default paper size - normally letter.
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No printing or print queue stopped.

Symptoms:

Upon sending a job to the printer, the job disappears 
completely and is not printed, or the job remains stalled in the 
Printer Setup Utility (Print Center).

Cause:

The Oki printer PostScript Printer Description (PPD) file has a 
dependency on a filter file. This filter file must be installed the 
following location:

/usr/libexec/cups/filter/OkfilterA

If this file is deleted, or is not present on your computer, jobs 
will not be sent to the printer at all. This can happen if you 
deleted this filter file, or if you copied a PPD file from another 
Mac and did not use the Oki Software installer.

Solution:

Run the Oki printer software installer contained on the CDs 
that were supplied with your printer. This will install the CUPS 
filter file and allow normal printing.
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